
Geochemical modeling
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You should be able to

1. explain what geochemical modeling is useful for

2. be familiar with Apps in the Community Edition of the Geochemist’s

Workbench

3. interpret and plot the output of a simple modeling run

4. describe how you can use geochemical modeling in environmental 

engineering challenges

Learning objectives
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▪ Geochemist’s Workbench Community Edition
https://community.gwb.com/community_download.php

▪ Geochemical and Biogeochemical Reaction Modeling by Craig M. 
Bethke (Cambridge University Press)

▪ Many examples that we cover here are from the GWB Essentials Guide 
(by Craig M. Bethke, Brian Farrell, Sharon Yeakel)

▪ There are many other geochemical modeling tools available
(e.g. PhreeqC, Visual Minteq, CHESS, Reaktoro, etc.)

▪ A quite extensive list of tools is provided on the USGS website

Resources
E

N
V

 2
0
0
: 

G
e
o
c
h
e
m

ic
a
l 
M

o
d
e
lin

g

M
e
re

t 
A

e
p
p
li

3

https://community.gwb.com/community_download.php
https://water.usgs.gov/water-resources/water-resources-software-catalog/


In almost all environmental problems, there is a need for knowledge or predictions of the solute 

concentrations in space and time.

▪ Contamination issues

• Examples:

▪ What will happen to a particular toxic chemical component or species in groundwater downstream 

from a contamination source such as a polluted industrial manufacturing site?

▪ How fast will the contaminant progress downstream, and when will it reach a certain point?

▪ What processes will slow down its movement (retardation) or immobilize it?

▪ Will the concentrations of the contaminant be above regulatory thresholds? Would the remediation 

methods be effective, i.e., limiting the migration of a contaminant and lowering its concentrations? 

• These questions may also be posed for the history of a site concerning past activities: what has 

happened at this site in the past?

▪ Water resources issues

• Example: Water is clear and uncontaminated, but just how much is there to tap and who is entitled to

what proportions? In this case, chemical constituents in groundwater and their movement can help

delineate the flow system that hydraulic data alone fail to reveal

What is geochemical modeling?
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▪ High-Level Radioactive Waste Disposal

▪ Mining-related environmental issues

▪ Landfills

▪ Geological carbon sequestration

▪ Deep well injection of hazardous wastes

▪ Artificial recharge to aquifers

Environmental engineering applications
E

N
V

 2
0
0
: 

G
e
o
c
h
e
m

ic
a
l 
M

o
d
e
lin

g

M
e
re

t 
A

e
p
p
li

5



Ultimately, we want to describe the complete chemical composition of a 

system (e.g. a lake, a soil column, an aquifer)

There are two ways to accomplish this:

▪ Thermodynamic description: If a closed system is at equilibrium, its 

chemical composition is uniquely defined.

▪ Kinetic description: If equilibrium is not attained (slow reactions) or if 

the system it is continuously perturbed (i.e. biological activity), a kinetic 

description is necessary.

Here, we will focus on the thermodynamic description.

What do we want to accomplish?
E

N
V

 2
0
0
: 

G
e
o
c
h
e
m

ic
a
l 
M

o
d
e
lin

g

M
e
re

t 
A

e
p
p
li

6



▪ We have discussed different chemical reactions in this class:

• Acid-base reactions

• Complexation reactions

• Dissolution/precipitation reactions

• Redox reactions

▪ You have learned to predict how a system behaves considering a few 

reactions that are at equilibrium simultaneously:

• For example, the carbonate system or reductive dissolution of iron minerals

• Complex calculations and/or graphical solutions can help solving these systems

▪ However, in natural systems, many or even all reaction types mentioned 

above may operate simultaneously, forming extremely complex reaction 

networks.

Natural systems are complex
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We could set up a mathematical framework. We already have

▪ Mass law equations

A2+ + 2B- = AB2

K = 
{𝐴𝐵2}

𝐴2+
𝐵
−

2

▪ Mass balance equations

[B-] + 2[AB2] + [CB(s)] = [B]tot

▪ Charge balance equations

2[A2+] + [B+] – [B-] = 0

How do we deal with complexity?
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1. Develop a conceptual model: List the processes that likely determine 

the chemical composition of a system.

2. Make partial equilibrium assumptions: Consider the timeframes in 

which you wish to understand a system (minutes? years? millions of 

years?). Decide which of the relevant reactions will reach equilibrium 

in this timeframe, and which ones will not proceed to any relevant 

degree.

3. Make sure you have thermodynamic parameters for these reactions.

4. Solve all equations simultaneously with a numerical model.

5. Interpret the output with respect to your conceptual model.

6. Potentially revise the conceptual model and start over.

Workflow for thermodynamic modeling
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▪ A model is a simplified abstraction of nature.

▪ It is described by a set of mathematical expressions thought to 
represent natural processes in a particular system.

▪ The model is built by you! You chose what data to use, which software 
is appropriate, which results are reasonable.

1. The conceptual model
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2. Partial equilibrium assumptions
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▪ Which timeframe is important for the processes you are interested in? 
Which of the relevant reactions will reach equilibrium in this timeframe?



▪ Kinetic information can be introduced into equilibrium calculations.

▪ Partial equilibrium assumptions

• consider only fast reactions with half-lives much smaller than the reaction 
time scale we are interested in (t1/2 << tr)

• ignore slow reactions in which half-lives are much larger than reaction times 
(t1/2 >> tr)

▪ This becomes problematic if reactions with half-lives close to the 
reaction times are important (t1/2 ≈ tr). In this case, we would need 
kinetic modeling.

2. Partial equilibrium assumptions
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3. Thermodynamic data
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▪ Here, we are using the Geochemist’s Workbench. 

▪ The remainder of the class will focus on how to use this software.

4. Solve equations using a numerical model
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1. Develop a conceptual model: List the processes that likely determine 

the chemical composition of a system.

2. Make partial equilibrium assumptions: Consider the timeframes in 

which you wish to understand a system (minutes? years? millions of 

years?). Decide which of the relevant reactions will reach equilibrium 

in this timeframe, and which ones will not proceed to any relevant 

degree.

3. Make sure you have thermodynamic parameters for these reactions.

4. Solve all equations simultaneously with a numerical model.

5. Interpret the output with respect to your conceptual model.

6. Potentially revise the conceptual model and start over.

Workflow for thermodynamic modeling
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Geochemist’s Workbench 
Installation guide

E
N

V
 2

0
0
: 

G
e
o
c
h
e
m

ic
a
l 
M

o
d
e
lin

g

M
e
re

t 
A

e
p
p
li

16

160

160

120

120

80

80

m/day

5
5

¶‚

0

5

10

15

20

0 5 10 15 20
Beidellit-Ca (volume%)

0 31.5

Day 20



▪ The Geochemist’s Workbench 
is not available for MacOS or 
Linux systems

▪ If you are working with 
MacOS (or Linux), please find 
another student whose PC is 
running on Windows and work 
together

Information
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Installation guide
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Go to https.//www.gwb.com/store.php and add GWB community to your 
chart ($0).



Installation guide
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You will receive an email with a link to the download. Download and 
install following the prompts on the screen.



Installation guide
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Once installation is complete, open the software. Input the activation code 
you received by email and click activate, then finish.



Installation guide
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Open Geochemist’s Workbench. It should look like this:



Introduction to the 
Geochemist’s Workbench
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We will use the following Apps here:

▪ GSS is a spreadsheet designed for 
manipulating and plotting geochemistry 
data

▪ Rxn balances chemical reactions and 
calculates equilibrium constants, 
temperatures, and equations

▪ Act2 generates stability diagrams on 
activity, Eh, pe, pH, and fugacity axes

▪ SpecE8 computes the distribution of 
species, sorption onto surfaces, mineral 
saturation, gas fugacity, and isotope 
fractionation in aqueous solutions

The Geochemist’s Workbench Essentials
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▪ GSS is a spreadsheet designed for geochemists. The program works 
with the other software tools in The Geochemist’s Workbench. You 
enter, paste, or drag the analyses for your samples into a GSS data 
sheet.

▪ You can then convert units, create plots and diagrams, mix samples, 
compare replicate analyses and check standards, calculate speciation 
and saturation, and more. You can drag samples into the other GWB 
apps, and drag calculations results from the other apps into GSS.

GSS: The Geochemist’s Spreadsheet
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Open GSS, go to File → Open and select the file “RiverWaters.gss”

GSS: The Geochemist’s Spreadsheet
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Samples

Analytes



Select one or more analytes, right click in the unit field to show a selection of units.

GSS: Converting units
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Go to Plot and choose from the list of plots and diagrams.

GSS: Plotting data
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You can add 
more samples

You can add 

more analytes



Chose XY Plot → Cross Plot. This will open Gtplot to generate the following:

GSS: Plotting data
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In Tab X Axis, you can 

chose which parameter 

to show on the X axis



To change the appearance of the plot, go to Format → Appearance

GSS: Plotting data
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Go back to the initial GSS table. Click on + analyte → Calculate with SpecE8 → Hardness.
A row with water hardness values is added to the table.

GSS: Calculate water hardness
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𝐻𝑎𝑟𝑑𝑛𝑒𝑠𝑠 𝑖𝑛 𝑚𝑚𝑜𝑙 𝐿−1 ≈

𝐶𝑎 𝑖𝑛 𝑚𝑔 𝐿−1

40
+

𝑀𝑔 𝑖𝑛 𝑚𝑔 𝐿−1

24.3



Interpreting the data
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Why is the water of the Mississippi River harder than the water of the 
Amazon River?



Particulate and dissolved Fe and Mn 
concentrations in Lake Cadagno
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Iron(III) compounds are reductively dissolved in the anoxic zone. Why do we see an 

increase in particulate iron and decrease in dissolved iron below the chemocline?

Ellwood, MJ et al., Geochim Cosmochim Acta, 2019, 255, 205-221.

Fe(III)

Fe(II)

Mn(IV)

Mn(II)

Oxic layer

Chemocline

Anoxic layer



Iron redox processes
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▪ The decrease in dissolved and increase in 
particulate Fe concentrations suggest that 
iron phases are precipitating.

▪ Which method could you use to figure out 
which phases are precipitating?

=> Eh-pH diagram

Ellwood, MJ et al., Geochim Cosmochim Acta, 2019, 255, 205-221.



EH-pH stability diagram
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▪ Open the Act2 App in the GWB Software

▪ Enter the input parameters

Act2: Create stability 
diagrams 
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EH-pH stability diagram
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Which parameters do you need? (These are given in the paper 
referenced below)

▪ Temperature: 5.5 °C

▪ Pressure: 1 bar

▪ Total iron concentration: 1 µmol/L

▪ Bicarbonate: 1 mmol/L

▪ Calcium: 1 mmol/L

▪ Sulfate: 3 mmol/L

▪ Phosphate: 3 µmol/L

Ellwood, MJ et al., Geochim Cosmochim Acta, 2019, 255, 205-221.
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Select main 
species to 
diagram

Configure your diagram 
on the Basis pane

Set 
activity
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Choose H+

for x axis
Set pH units
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Choose O2(aq) for y 

axis, then swap in the e−

Set Eh units
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Add any 

background 

ions
Set temperature
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Run → Go 

draws the diagram
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Move to the 
Plot pane.

Minerals plot in orange, 
aqueous species in blue



EH-pH stability diagram: Solution
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EH-pH stability diagram: Solution
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▪ Now add the data from the figure on the 
right into your EH-pH diagram.

▪ To do so, create a GSS file, add the data, 
and then drag and drop it into your EH-pH 
diagram.

Ellwood, MJ et al., Geochim Cosmochim Acta, 2019, 255, 205-221.



EH-pH stability diagram: Solution
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FeS is expected to precitipate in the anoxic zone and likely causes the 
increase in particulate concentrations we observed.



EH-pH stability diagram: Solution?
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Why is there no increase in particulate Mn?



EH-pH stability diagram: Solution?
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Why is there no increase in particulate Mn?

Minerals may not precipitate 
even if the conditions (Eh, pH) 
are within their 
thermodynamic stability field:

▪ Kinetic factors: Activation 
energy, temperature 
dependence

▪ Nucleation barriers: 
Achieving a stable nucleus 
in solution is energetically 
unfavourable for some 
minerals, often there is also 
a certain degree of 
supersaturation necessary

▪ Solution chemistry: 
complexation and ligand 
effects, competing reactions 
that are not all represented 
in this conceptual model



EH-pH stability diagram: Solution
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Stay in the 
Plot pane.

Go to “Config” > 

“Suppress…”

Search and 

select phases to 

suppress. 

=> MnHPO4(c)

List of suppressed 

phases



EH-pH stability diagram: Solution
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Why is there no increase in particulate Mn?

Minerals may not precipitate 
even if the conditions (Eh, pH) 
are within their 
thermodynamic stability field:

▪ Kinetic factors: Activation 
energy, temperature 
dependence

▪ Nucleation barriers: 
Achieving a stable nucleus 
in solution is energetically 
unfavourable for some 
minerals, often there is also 
a certain degree of 
supersaturation necessary

▪ Solution chemistry: 
complexation and ligand 
effects, competing reactions 
that are not all represented 
in this conceptual model



▪ Why is it important to understand Se speciation?

▪ Selenium is a trace element. It is an essential element as it 

forms part of enzymes but is toxic in high concentrations.

▪ The environmental contamination of selenium is a growing 

global concern due to rapidly increasing quantities being 

introduced by modern agricultural, mining, and energy 

generation practices.

▪ The bioavailability and therefore toxicity are highly contingent 

on the selenium species in question.
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Luoma, NL and Presser, TS, Environ Sci Technol, 2009, 43(22), 8483-8487.

Bailey, RT, Hydrogeol J, 2017, 25:1191-1217.

Selenium ecotoxicology



Create an EH-pH diagram with Act2
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Start the program and move to the Basis pane:

1. Under “diagram species”, click on “???” and select “SeO3−−”. Set 
activity to 10^-6.

2. Under “on axes”, for “on x axis” click on “???” and select “H+”. 
Change the unit from “log activity” to “pH”. The axis automatically 
spans from 0 to 14, but you can adjust the range.

3. For “on y axis” click on “???” and select “O2(aq)”. Click on the swap 
button next to the basis entry for “O2(aq)” and select Aqueous…→ e−. 
Change the unit from “log activity” to “Eh”.



You can copy your plot and 
paste it into your documents, 
including Microsoft Word, 
Excel, and PowerPoint, or 
Adobe Illustrator.

First, select Edit → Copy. Then, 
paste into PowerPoint as an 
Enhanced Metafile. Ungroup 
the image to enable editing

Act2: Export plots
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Act2: Output
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Go to Results pane and click “View Results” to see the output:



Act2: Output
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Act2: Output
All possible reaction equations are 

reported

The reaction equations used in the 
diagram are given

Equation number 
refers to the table 

above

Type describes the 
position relative to 
the stability area



Context: Selenium speciation in alluvial aquifers
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Bailey, RT, Hydrogeol J, 2017, 25:1191-1217.

Se movement in soil and aquifer systems is governed by redox reactions

which control speciation and sorption processes.

Selenate Selenite

Selenide
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▪ What are typical Eh and 

pH conditions for alluvial 

aquifers?

▪ Which species do you 

expect to be present 

under those condition?

▪ Researchers found 

Se(0) and organic Se2-

under aerated 

conditions. Why?

Selenium speciation in alluvial aquifers
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Bailey, RT, Hydrogeol J, 2017, 25:1191-1217.

Typical conditions 
in alluvial aquifers



1. Geochemical modeling is used to obtain information on solute 
concentrations in space and time.

2. The model is always a simplification of a complex real system. We 
therefore need to be careful with our assumptions and interpretation of 
the modeling output.

3. The GSS spreadsheet in the Geochemist’s Workbench can be used to 
convert units, create plots and combined with other GWB apps.
(We will talk more about this when discussing the SpecE8 app!)

4. Using the Act2 app in the Geochemist’s Workbench, you can create 
stability diagrams in an easy and fast manner. These diagrams can 
help you get a quick grasp on the prevailing conditions in the 
environmental system of interest.

Summary
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